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Tutorial 3: Automatic Entrance Door  

1. Introduction 

1.1 What Am I Learning Here, and Why?  
In this tutorial you will learn how an automatic entrance door, triggered by an electronic key 

card or fob, can be installed as an entrance door in a home. Additionally, you will also learn 

how to install a motion sensor which will instruct you to present your fob to open the entrance 

door.  

The automatic entrance door is accomplished by having the door connected to a motor which 

is triggered by a reader device which sends a signal to open the door when presented with a 

specifically programmed key card. Through these mechanisms and specific computer coding, 

an automatic entrance door can serve a user with ease. An installation such as this can be 

very helpful as it simplifies procedures and can save a person time. An automatic entrance 

door can also have additional security benefits; such as the door automatically closing once 

the person has entered.  

1.2 Learning Objectives 
In this tutorial you will learn how to install and use an automatically opening and closing 

entrance door using a PIR motion sensor, RFID reader, a servo motor and the Raspberry Pi 

Pico system. The tutorial is based on a scenario where a person approaches an entrance, 

thus, triggering the motion sensor which instructs them to present their fob. Once the correct 

fob is presented to the reader, the door will automatically open, granting them access. This is 

a basic process of how actions, such as opening an entrance, can be done automatically 

through a computer system. 

After you have completed this tutorial, you will be able to  

o Install and use a PIR motion sensor to detect an oncoming person and instruct them 

to present a fob to open an entrance door. 

o Install and use an SG-90 Servo Motor to automatically open an entrance door. 

o program an RFID Reader and fob to work as a verification system to operate other 

mechanisms (such as using a fob as an electric key card to open a door). 

o Install, program, and use a RFID Reader to trigger a SG-90 Servo Motor to 

automatically open an entrance door. 

o demonstrate an automatic entrance door system on the SmartHome4Senior wooden 

house model. 

1.3 What Do I Need?  
Software 

To successfully carry out the installations shown in this tutorial you must have downloaded the 

Thonny computer programme on your computer (p. 13). It is recommended that your computer 

has Windows 11, or a more recent Windows operating system. To achieve this task, you must 

also have installed the Micro Python firmware on your Raspberry Pi Pico system (p. 14). 

Instructions can be found in the SmartHome4Seniors manual. 

 

Electrical Hardware 

• 1 x Raspberry Pi Pico 
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• 1 x Full sized breadboard 

• 1 X micro-USB cable 

• 1 x MB-102 power module 

• 6 x AA Batteries 

• 1 x SG-90 Servo Motor 

• 1 x PIR Motion sensor 

• 1 x RFID RC522 module 

• 1 x RFID tag 

• 10 x Male-to-male jumper wires 

• 11 x Male-to-female jumper wires 

To attach components at SmartHome4Seniors house model, you will need: 

• 2 x M2 metal screws 

• 2 x M2 metal nuts 

• 2 x wood screws 

• 2 x metal screws that come with the SG90 servo motor 

• 1 x Phillips screw driver  

Ability 

Only basic physical abilities are needed; including being able to count holes (on the 

breadboard), insert components and wires, and be able to attach components to the 

SmartHome4Seniors kit’s wooden model house.  

2. Learning Content   

2.1 Theoretical Background 
In this section you will learn of what exactly you are installing, programming and controlling 

via the actions you take throughout this tutorial.  

SG-90 Servo Motor:  

A servo motor receives a control signal that represents the desired position or speed, and 

utilizes a feedback system, typically an encoder, to precisely control and adjust its position or 

speed to match the input command. The motor's controller compares the actual position or 

speed of the motor to the input command, and if there is a discrepancy, it generates a 

corrective signal to adjust the motor's position or speed accordingly, making servo motors 

highly accurate for positioning tasks. This makes it ideal for tasks such as creating entrances; 

for example, barriers or garage doors. They are highly functional, operable and can be 

programmed for specific needs.  

 

PIR Motion Sensor:  
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A passive infrared (PIR) sensor is an electronic sensor that measures infrared light radiating 

from objects in its field of view. When an object or person passes in front of this sensor, which 

could be stationed on a wall or within an object, it can detect the fluctuation in infrared 

temperature. The sensor converts the resulting change in the incoming infrared radiation into 

a change in the output voltage. This triggers the detection and allows for the sensor to send a 

signal to the connecting system alerting it of the change. This makes the sensor an ideal 

trigger for mechanisms which prefer to operate automatically upon approach; for example, 

entrance doors or hand sanitising stations.  

 

RFID Reader: 

Radio frequency identification devices (RFID) are an essential part of many security systems 

as they work as a personalised electronic lock and key system. Programmes or electronic 

modules which are to be kept secure are often hidden behind RFID systems. RFID cards act 

as the ‘key’, often referred to as a fob, and card readers act as the electronic barrier between 

the service user and then service secured by the RFID system. RFID cards store a unique 

identification number that is wirelessly detected by a RFID card reader attached to a wall. If 

the RFID card’s identification number matches an identification number from a stored list of 

authorized cards, the service or door is unlocked and the cardholder can enter the room. 

 

 

 

2.2 Step-by-Step Guide 
So let’s get started.  

Introduction 

1. The automatic entrance door is achieved through the amalgamation of the SG-90 Servo 

Motor tutorial (p. 49), the PIR Motion Sensor tutorial (p. 63) and the RFID Reader (p.65). 

Before committing to this exercise, it is recommended that you first become familiar with 

these previous three tutorials. Otherwise, continue to step 2.  

2. Gather all needed materials mentioned above to install and programme the automatic 

entrance door.  
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3. If not completed already, install the Thonny computer programme on your computer. 

Furthermore, install the Raspberry Pi Pico firmware. For more information on this see pp. 

13-14 of the SmartHome4Seniors manual. 

4. Connect the Raspberry Pi Pico Micro controller to the breadboard. Once connected, 

connect the Raspberry Pi Pico micro controller to your computer/laptop using the USC 

cable.   

2.2.1 Attaching the components to the SmartHome4Seniors House Model 
It is assumed that you have already constructed the SmartHome4Seniors wooden house 

model as you should have completed the previous tutorials.  

 

1. Place the microcontroller and breadboard, and all components attached to it inside the 

SmartHome4Seniors wooden house model. 

o Remember to keep the wooden house model within reach of your computer/laptop.  

o All wires (male-to-male & male-to-female) can be exchanges for longer or shorter 

wires if needed. However, remember to install the wires exactly where they were 

beforehand. Use the installation images shown above as a guide.  

 

2. Install the SG-90 motor (looking from the outside) on the left-hand side of the door 

entrance. 

o The motor has to be put in place from the inside of the wooden model house. 

Thereafter, the screws are used to hold it place (screwing from the outside of the 

house towards the inside).  

o Make sure to place the motor in the correct way; making sure that rotary blade has 

room to manoeuvre so it can act as an entrance door.  

o Use 2 x M2 metal wood screws to hold the sensor in place  

See image(s) below for guidance:  
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3. Install the PIR Motion Sensor (looking from the outside) above the door entrance.  

- The sensor must be put in place from the outside of the wooden model house. To do 

this, remove the wires connecting to the sensor, place it within the window above the 

door with the area where wires connect sticking through the top window.  

- Once in place, reconnect the wires. Make sure to connect them exactly how they 

were before they were removed. For guidance look and the imagery provided above.  

- Use 2 x M2 metal screws and nuts to hold the sensor in place. 

 

See image(s) below or guidance:  

 

4. Place the RFID reader on the front of the SmartHome4Senior wooden model house.  

- The male-to-female wires will fit through the gap in the wood and extend down to the 

breadboard within the house model.  

- Use 4 x M2 metal screws and bolts to hold it in position  
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See image(s) for guidance:  

 

5. Finally, you must create the door by attached the wooden door to the motor.  

o Remove the plastic rotor from the motor.  

o Place the rotor on top of the wooden door 

o Use the wood screws located in the plastic bag holding the motor’s spare rotors, 

screw the plastic rotor into the wood near the tip.  

o Press the rotor, with the wood attached onto the motor again.  
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See image(s) for guidance:  

 

2.2.2 Preparing the Physical Components 
Now, prepare the breadboard with the advanced tutorial setup indicated on p.42 of the 

SmartHome4Seniors manual.  

See steps below:  
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o Top side connections: VSYS 5V ((+) red) and GND ((-) black) 

o Bottom side connections: 3V3 ((+) red) and GND ((-) black) 

o Place the power supply module on the opposite end to the micro controller. 

o Place 6 AA batteries into the battery holder and connect it to the supply module using 

the wire attached.  

See image(s) below for guidance: 

 

 

 

Input the SG-90 Sensor motor first. 

o Connect red cable to 5V rail (+) 

o Connect black/brown cable to GND rail (-)  

o Connect orange cable to GPIO0 pin 

 

Input the PIR Motion Sensor onto the breadboard alongside the SG-90 Sensor Motor’s 

setup.  

o Connect VCC (red cable) to 5V rail (+) 

o Connect GND (black cable) to GND rail (-) 

o Connect OUT (yellow cable) to GPIO22 pin.  

 

Input the RFID Reader RC522 onto the breadboard alongside the Servo motor and the PIR 

motion sensor. As there are a lot of wires, be careful that everything is installed correctly. Be 

aware that, because the RFID Reader is to be mounted onto the wooden house model, you 
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will need to use 8 x male-to-female jump wire to connect the RFID Reader to the 

Breadboard. 

o Connect 3v3 (red cable) to 3v3 rail (+) 

o Connect GND (black cable) to GND rail (-) 

o Connect RST (purple cable) to GPIO28 pin 

o Connect SDA (green cable) to GPIO16 pin 

o Connect SCK (yellow cable) to GPIO18 pin 

o Connect MOSI (orange cable) to GPIO17 pin 

o Connect MISO (blue cable) to GPIO19 pin 

o To allow for the RFID reader to be placed on the house model, you will need to 

use 8 x male-to-female jump wires connecting the RFID reader to the same 

points in the breadboard as in the images below 

See image(s) below for guidance:  

 

 

2.2.2 Inputting the Code and programming the Components 
Before completing this task, you need an additional library that controls the RFID module, 

namely the MFRC522 library. You will need to install this library to your Raspberry Pi Pico 

using the “Install Packages” option on the menu of Thonny Python. 

You can download it from https://github.com/wendlers/micropython-

mfrc522/blob/master/mfrc522.py  

o Download the file and open it in Thonny Python.  

https://github.com/wendlers/micropython-mfrc522/blob/master/mfrc522.py
https://github.com/wendlers/micropython-mfrc522/blob/master/mfrc522.py
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o Then click File → Save as… choose Raspberry Pi Pico and save your file under 

the name mfrc522.py.  

 

Then, you need to identity the fob’s ID to make the RFID reader to work. To do that you need 

to create a program that reads the RFID Fob and gives its ID.  

- Input the code below. 

from mfrc522 import MFRC522 

import utime 

 

PIN_SDA = 16 

PIN_SCK = 18 

PIN_MOSI = 17 

PIN_MISO = 19 

PIN_RST = 28 

 

RFID = MFRC522(spi_id=0, sck=PIN_SCK, miso=PIN_MISO, mosi=PIN_MOSI, 

cs=PIN_SDA, rst=PIN_RST) 

 

print("Bring RFID FOB closer...") 

print("") 

 

 

while True: 

    RFID.init() 

    (stat, tag_type) = RFID.request(RFID.REQIDL) 

    if stat == RFID.OK: 

        (stat, uid) = RFID.SelectTagSN() 

        if stat == RFID.OK: 

            fob = int.from_bytes(bytes(uid),"little",False) 

            print("FOB ID: "+str(fob)) 

            utime.sleep_ms(500) 

 

 

Click Play and scan the fob. This will give you its ID. 

- Save the fob ID as you will need this later.  

 

The tutorial, uses a MicroPython package, called servo.py. You will need to add this package 

to your Raspberry Pi Pico. Please follow the instructions below. 

 

Since the servo motor operate using the PWM principle, this tutorial makes it easy for you to 

calculate the correct angle the garage door should open. To do that, first you will need to add 

a library to your Raspberry Pi Pico.  

 

Open Thonny Python and create a new file by clicking File → New or by hitting Ctrl+N on 

your keyboard. 
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Then make sure the Raspberry Pi Pico is connected. You should see on the right corner of 

Thonny’s window the message “MicroPython (Raspberry Pi Pico)”. If this is not the case, 

please jump back to the Kit’s manual and follow the instructions on how to properly install 

the firmware. 

 

After making sure the Pico is connected, you should click on Tools → Manage packages.  

 

On the search bar write “micropython servo” and click Search. 
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Click on micropython-servo and then click on Install. Wait for installation to complete and then 

click Close. 

 

5. You are ready to create the automatic entrace door program. Now, On the Thonny 

computer programme, Open a new file. Then, save file to the Raspberry Pico with the 

name ‘autoentrance.py’.  

o Click the save icon on the top left of the Thonny window or click ‘file’, followed by 

‘save’, or the CTR+S keys. 

o A window will appear asking “where to save to?”. Choose Raspberry Pi Pico. 

o Save filename as ‘autoentrance.py’  

See image(s) below for guidance.  
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The coding for this tutorial is an amalgamation of the servo motor, PIR sensor and the RFID 

reader. Copy and paste the code below, also see the image for guidance.  

 
from machine import Pin 

from servo import Servo 

from mfrc522 import MFRC522 

from time import sleep 

 

#Define pins for each component 

PIN_DOOR = 0 

PIN_PIR = 22 

PIN_SDA = 16 

PIN_SCK = 18 

PIN_MOSI = 17 

PIN_MISO = 19 

PIN_RST = 28 

 

#Setup entrance door 

door = Pin(PIN_DOOR) 

entrance_door = Servo(pin_id=door) 

entrance_door.write(120) #number should be adjusted depending on 

at what angle you have placed the door on the servo motor 

sleep(0.5) 

 

#Setup PIR sensor 

PIR = Pin(PIN_PIR, Pin.IN, Pin.PULL_UP) 

 

#Setup RFID Reader RC522 

RFID = MFRC522(spi_id=0, sck=PIN_SCK, miso=PIN_MISO, 

mosi=PIN_MOSI, cs=PIN_SDA, rst=PIN_RST) 

 

while True: 

    if PIR.value() == 1: 

        print("Scan your Key!") 

        sleep(3) 

    if PIR.value() == 0: 

        print("") 

        sleep(3) 

         

    RFID.init() 

    (stat, tag_type) = RFID.request(RFID.REQIDL) 

    if stat == RFID.OK: 

        (stat, uid) = RFID.SelectTagSN() 

        if stat == RFID.OK: 

            fob = int.from_bytes(bytes(uid),"little",False) 

            if fob == 470550832: #change number to your fob ID 

                print("Fob ID: "+ str(fob)) 

                #enable servo motors 
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                entrance_door.write(200) #number should be 

adjusted depending on at what angle you have placed the door on 

the servo motor 

                sleep(5) 

                entrance_door.write(125) 

            else: 

                print("Fob is not accepted") 

 

 

See image(s) for guidance:  
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The code contains information to detect motion (PIR value is 1) and if so it prints a message 

instructing the user to scan their key and then waits for 1 second. Next, the code starts the 

RFID reader checking if it reads and RFID card. If so it compares the ID with a specific 

number and opens the door using the servo motor installation if the numbers match. 

2.2.3 Application 
You have now completed installing an automatic entrance door on the SmartHome4Seniors 

house model.  

If you try this now by clicking “run” / play button, the following should happen: The PIR 

motion sensor should detect when something or someone approaching the entrance door. 

Then, upon placing the fob on the RFID Reader the motor should rotate. 

 

3. Summary  
In this tutorial you have learned one way that an automatic entrance door could be installed 

and programmed in a home using some basic components and computer programming. 

These components were the PIR Sensor, the SG-90 Motor and the RFID Reader. You have 

achieved the following:  

o Successfully inputted all the components and wires into the breadboard. 

o Successfully programmed the 3 components two work together using Micro Python 

through the Thonny computer programme. 

o Successfully demonstrated how an automatic entrance door on the 

SmartHome4Seniors wooden house model. 
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Now that you have completed the tutorial, you should have a better understanding of all the 

mechanisms that work together to serve a user in their home.  
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